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				To get a PDF’s text length, first, you'll need to copy the text. You can easily do this using a tool such as Slim PDF Reader or Able2Extract Professional:

	In Slim PDF Reader, simply copy the text by opening the document in the program and selecting the content by using CTRL + A.
	In Able2Extract Professional, open your file and click on the "Select All" option.
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				After you've copied the text, it's time to get its total length. For this, we suggest you use WordCounter.net. This is how you can find a document’s length:

	Go to WordCounter.net.
	Paste the copied text, and you'll see its length at the top of the page.
	To edit your PDF before or after counting its words, use our online PDF editor.
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Why You Would Get A PDF Word Count

This task can be valuable for various reasons, including:

	Assessing Reading Time: Word count helps gauge the document's length, which can be useful for estimating reading time or evaluating the document's comprehensiveness.
	Meeting Word Limits: In academic or professional writing, adhering to word limits is crucial. Counting words ensures compliance with specified requirements.
	Content Analysis: Analyzing word counts can reveal patterns in the document's content, such as frequently used terms or topics of emphasis.
	Quality Control: Reviewing word counts can help identify potential issues like excessive verbosity or insufficient elaboration, allowing for content optimization.
	Translation Services: Word counts are essential when requesting translation services, as they determine the cost and scope of translation work.
	Search Engine Optimization (SEO): In digital marketing, word count can impact SEO rankings. Longer content may rank better in search engine results pages (SERPs).
	Legal and Regulatory Compliance: Some legal and regulatory documents have word count requirements. Ensuring compliance is essential for legal accuracy.
	Publication and Printing Costs: Publishers and printers often charge based on word count or page count, making accurate word counting crucial for cost estimation.
	Content Creation: Content creators and writers may use word counts as targets or milestones to manage their writing tasks effectively.
	Comparative Analysis: Word counts allow for easy comparisons between different versions or drafts of a document, aiding in the editing and revision process.


Tips About Getting A PDF Word Count

Now that you know the best way to tally up the text in PDFs, it's time to find out a few aspects of this process that you need to account for. These aspects are as follows:

	Convert PDF To Word: Microsoft Word is one of the widely used text apps that people use to count words. Moreover, alongside counting words, Word is also capable of counting characters (with and without spaces), pages, lines, and paragraphs. So to use Word to carry out this task, simply convert your PDF to Word.
	Edit Your PDF: Of course, you can make changes to your PDFs before or after counting the number of words if you want to. You only need to use our "Edit PDF" tool to edit your file. The advantage of our tool is that it’s web-based, so you don't have to install any new apps on your device.
	Select All Text: Ensure all text is selected, including hidden or non-visible text. Use the "Select All" function in your word processing software.
	Check for OCR Text: If the document contains scanned images, use Optical Character Recognition (OCR) software to convert the images to searchable text before counting words.
	Account for Headers and Footers: Exclude headers, footers, page numbers, and any repetitive content that shouldn't be included in the word count.
	Check for Hyphenation: Decide whether hyphenated words should be counted as one word or multiple words based on your specific requirements.
	Consider Language Settings: Ensure that the language settings of the word counting tool match the language used in the file to get accurate counts.
	Handle Non-Standard Fonts: Some fonts and characters may not be recognized correctly by word counting tools, so manual verification may be necessary.
	Account for Line Breaks: Check if the document has line breaks that could affect the word count. Adjust the counting method accordingly.
	Verify Accuracy: Double-check the word count using different tools or methods to ensure accuracy, especially for critical documents.
	Document Settings: Be aware of any document settings that may affect word counting, such as margins, line spacing, and font size.


Which Programs Allow You To Get A PDF Word Count

Even though using online tools to get a PDF’s text length is a clever choice, sometimes you might want to go for other alternatives. So, in this section, we'll see how you can get the length of PDFs in different operating systems and programs.

Windows

On Windows devices, there are a couple of effective ways to tally up the text without using online tools:

Adobe Acrobat Reader

Adobe Acrobat Reader is a popular program that often comes pre-installed on many Windows devices. If it's not already on your device, you can download and install it from Adobe's official website.

	Open your document with Adobe Acrobat Reader.
	Go to the "File" menu and select "Properties."
	Under the "Description" tab, you will find various details about the file, including the number of words in the document. This feature might not be available in all versions of Adobe Acrobat Reader, so it's important to check if your version supports it.


Microsoft Word

Microsoft Word, part of the Microsoft Office suite, can also be used to count words in a file.

	First, open Microsoft Word.
	Go to "File" and select "Open." Browse and select the file you want to check. Word will convert the PDF into an editable Word document. This process may alter the formatting of the document, but the text will remain.
	Once the document is open in Word, go to the "Review" tab.
	In the "Review" tab, click on "Word Count." A dialog box will appear, showing detailed statistics including the number of words in the document.


Mac

On Mac devices, there are a couple of effective methods to determine the word count of a file:

Preview and Automator

Mac's Preview app, combined with Automator, offers a unique way to count words in a document.

	First, open the file with Preview.
	Then, use the 'Select All' command (Command + A) to highlight all the text.

Copy the text (Command + C).

Next, open Automator (found in your Applications folder) and create a new 'Service'.

Set the service to receive 'no input' in 'any application' and drag the 'Run AppleScript' action into the workflow.

In the AppleScript, paste the following code:


arduino

Copy code

on run {input, parameters}

return count words of (the clipboard as text)

end run

Save this service. Now, you can access this service from any application by right-clicking and navigating to the 'Services' menu. After copying text from your document, use this service to tally up the text.

Terminal

Another alternative for obtaining a word count on a Mac, involves using a script in the Terminal. This method is more technical but can be quite effective, especially for users comfortable with command-line interfaces. Here's how:

Install a Text Extraction Tool:

	First, you'll need a tool that can extract text from a PDF file. One such tool is pdftotext, which is part of the poppler utilities. You can install poppler via Homebrew, a package manager for macOS. If you don't have Homebrew installed, you can install it from brew.sh.
	Once Homebrew is installed, open the Terminal and run the command brew install poppler to install the poppler utilities.


Extract Text and Count Words:

	With pdftotext installed, you can now extract text from your file. In the Terminal, navigate to the directory containing your document.
	Use the command pdftotext yourfile.pdf - (replace yourfile.pdf with the name of your file). This will convert the document to text and output it directly in the Terminal.
	To count the words, you can pipe the output to the wc (word count) command: pdftotext yourfile.pdf - | wc -w.
	This command will display the number of words in your file.


Linux

On Linux devices, there are several efficient methods to determine the word count of a PDF file. Here are two common approaches:

pdftotext and wc (Word Count) Command

Linux systems often come with a powerful set of command-line tools, and pdftotext is one such utility used to extract text from PDFs. It's part of the poppler-utils package.

	First, ensure that pdftotext is installed on your Linux system. You can usually install it via your distribution's package manager. For example, on Ubuntu, you would use sudo apt-get install poppler-utils.
	Once installed, you can use pdftotext to convert your document to a plain text file: pdftotext yourfile.pdf yourfile.txt (replace yourfile.pdf with the name of your file).
	After the text is extracted, use the wc command to count the words: wc -w yourfile.txt. This will display the number of words in the text file, which corresponds to the number of words in your original document.


pdfgrep

pdfgrep is a command-line tool similar to grep but designed specifically for searching text in PDF files. It can also be used to approximate the word count of a document.

	First, install pdfgrep if it's not already on your system. On Ubuntu, you can install it using sudo apt-get install pdfgrep.
	To count words, use the command pdfgrep -i "your search pattern" yourfile.pdf | wc -w. Replace "your search pattern" with a common word or character that's likely to appear frequently in your text (like 'the' or 'a'). This will give you an estimate of the total word count.


Android

On Android devices, getting a word count from a PDF file can be accomplished through various apps. Here are two methods:

Adobe Acrobat Reader for Android

Adobe Acrobat Reader is a widely-used PDF reader available on the Google Play Store.

	After installing the app, open your file with Adobe Acrobat Reader.
	While Adobe Acrobat Reader for Android may not directly show the word count, you can use its select and copy text feature. Select all the text in the file (this might need to be done page by page) and copy it.
	Then, paste the copied text into a word processor app that has a word count feature, like Google Docs or Microsoft Word, both of which are available for Android. These apps will display the word count for the pasted text.


Dedicated PDF Reader App with Word Count Feature

	Some PDF reader apps on the Android platform might include a word count feature. You would need to search the Google Play Store for a PDF reader app that specifically lists a word count feature in its description or feature list.
	Once you've found and installed an app with this functionality, open your file with the app, and use the word count feature to get the number of words in your document.


iPhone (iOS) Or iPad

On iPhone devices, there are a couple of practical methods to get a word count from a PDF file:

PDF Reader App with Copy-Paste Method

First, you'll need a PDF reader app that allows you to select and copy text. Apps like Adobe Acrobat Reader or Apple's Books app can be used for this purpose.

	Open the file in your chosen PDF reader.
	Use the text selection tool to highlight and copy the text. Depending on the app, you might have to do this for each page individually.
	Next, paste the copied text into a word processing app that has a word count feature, like Microsoft Word or Apple's Pages. Both apps are available on the App Store and can be used to calculate the word count of the pasted text.


Dedicated File Management App with PDF Support

Some file management apps on the iPhone, like Documents by Readdle, offer more robust PDF handling capabilities, which may include extracting text from PDFs.

	Install a suitable file management app from the App Store that supports PDF text extraction.
	Open the PDF file within this app and look for an option to extract or view the text of the PDF.
	Once the text is extracted or viewable, the app may offer a word count feature directly, or you can then copy and paste the text into a word processing app as mentioned in the first method to determine the word count.
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